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3Introduction

This manual describes detailed instructions on the operation and notes about the use of this machine.
To get maximum versatility from this machine all operators are requested to read this manual carefully
and follow the instructions. Please keep this manual in a handy place near the machine.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be
liable for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated.

Appletalk, Apple, Macintosh, Mac OS, Mac OS X is a registered trademark of Apple Computer, Incor-
porated.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows 95.

• The product name of Windows® 98 is Microsoft® Windows 98.

• The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

• The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition
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• The product names of Windows ServerTM 2003 are as follows:
Microsoft® Windows ServerTM 2003 Standard Edition
Microsoft® Windows ServerTM 2003 Enterprise Edition
Microsoft® Windows ServerTM 2003 Web Edition

• The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

• Microsoft® Windows NT® Workstation 4.0

Notes:

Certain options might not be available in some countries. For details, please contact your local dealer.
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Symbols

The following set of symbols is used in this manual.

R WARNING:

This symbol indicates a potentially hazardous situation that might result in death or serious injury when

you misuse the machine without following the instructions under this symbol. Be sure to read the in-

structions, all of which are described in the Safety Information section.

R CAUTION:

This symbol indicates a potentially hazardous situation that might result in minor or moderate injury or

property damage that does not involve personal injury when you misuse the machine without following

the instructions under this symbol. Be sure to read the instructions, all of which are described in the

Safety Information section.

* The statements above are notes for your safety.

Important

If this instruction is not followed, paper might be misfed, originals might be damaged, or data might be

lost. Be sure to read this.

Preparation

This symbol indicates information or preparations required prior to operating.

Note

This symbol indicates precautions for operation, or actions to take after abnormal operation.

Limitation

This symbol indicates numerical limits, functions that cannot be used together, or conditions in which

a particular function cannot be used.
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Reference

This symbol indicates a reference.

[ ]

Keys that appear on the machine's display panel.

[ ]

Keys and buttons that appear on the computer's display.

{ }

Keys built into the machine's control panel.

{ }

Keys on the computer's keyboard.
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Setting up Options

This documentation describes the specific printer functions and menus that are added by installing the

PPD file. For more information about the functions and menus of the Windows 95/98/Me PostScript

printer driver, see the printer driver's Help.

Preparation

For Macintosh, Mac OS 8.6 or a later version, or Mac OS X 10.1 or a later version is required. Mac

OS X classic is also supported.

Limitation

❒ If you use Mac OS X, the following functions cannot be used:

• Sample Print

• Locked Print

• User Code

Note

❒  “Mac OS X” in the tables below refers to Mac OS X 10.2.3. Depending on the version, [Features x]

is displayed as [Set x] (x is a number). Make adjustments according to the version you use.
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Job Type

Use this to select the type of print job.

The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖❖❖❖ Normal
Select this for normal printing. The print job starts immediately after the print command is given.

Note

❒ Under Windows 95/98/Me, if you want to use an User ID, click the [Detail] button.

❖❖❖❖ Sample Print
Use this function to print only one set of a multiple print jobs.

The other sets are saved in the machine. The saved job can be printed from the machine's control

panel. You can also delete the saved job.

Windows 95/ 98/ Me [Job Type] on the [Setup] tab.

Windows 2000/XP, Windows Server 2003 [Job Type] on the [Job Log] tab in the Printing Preferences dialog box.

Windows NT 4. 0 [Job Type] on the [Job Log] tab in the Document Defaults dialog box.

Mac OS [Job Type] on [Job Log] in the print dialog box.

Mac OS X This function is not available.
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Limitation

❒ To use this function, the optional Hard Disk Drive must be installed on the printer.

Note

❒ The "User ID" can consist of up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

❒ Entering the "User ID" helps you to distinguish the print job from others.

Reference

For more information about how to use Sample Print, see p.10 “How to Use Sample Print”.

❖❖❖❖ Locked Print
Use this function to save documents in the machine memory with a password, and then edit and print

them as you want.

Limitation

❒ To use this function, the optional Hard Disk Drive must be installed on the printer.

Note

❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters. The "Password"

must be four digits.

Reference

For more information about how to use Locked Print, see p.13 “How to Use Locked Print”.
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How to Use Sample Print 

Follow the procedures to print a document using the "Sample Print" function.

Note

❒ If the application has a collate option, make sure that it is not selected before sending a print job. By

default, sample print jobs are automatically collated by the printer driver. If the collate option is se-

lected in the application print dialog box, more prints than intended may be printed.

Windows 95/98/Me

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties to set Sample Print.

CCCC Click to select the [Setup] tab.

DDDD Select [Sample Print] in [Job Type].

EEEE Click [Details...].

FFFF Enter the "User ID" in [User ID]. This can consist of up to eight alphanumeric (a- z, A- Z, 0- 9)

characters.

Note

❒ Select this to identify the user associated with the job.

GGGG Click [OK].
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Windows 2000/XP, Windows Server 2003, Windows NT 4.0

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties to set Sample Print.

CCCC Click to select the [Job Log] tab.

DDDD Select [Sample Print] in [Print Job].

EEEE Enter the "User ID" in [User ID]. This can consist of up to eight alphanumeric (a- z, A- Z, 0- 9)

characters.

Note

❒ Select this to identify the user associated with the job.

FFFF Click [OK] to close the Printer Properties.

GGGG Start printing from the application's print dialog box.

The Sample Print job is sent to the machine and one set is printed.

HHHH Check the sample print to confirm that the settings are correct.

If the settings are correct, see "Printing the Remaining Sets" in the Client Reference.

If not, you can delete the saved job. See "Deleting a Sample Print File" in the Client Reference.
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Mac OS

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Click to select [Job Log] from the pop up menu.

CCCC Select [Sample Print] in [Job Type], and then select the appropriate setting.

DDDD Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. 

Note

❒ This is used to identify the user associated with a job.

❒ The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

EEEE After making all of the settings you want, click [Print].

The Sample Print job is sent to the machine and one set is printed.

FFFF Check the sample print to confirm that the settings are correct.

If the settings are correct, see "Printing the Remaining Sets" in the Client Reference.

If not, you can delete the saved job. See "Deleting a Sample Print File" in the Client Reference.
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How to Use Locked Print

Follow the procedures to print a document using the "Locked Print" function.

Note

❒ If the application has a collate option, make sure that it is not selected before sending a print job. By

default, locked print jobs are automatically collated by the printer driver. If the collate option is se-

lected in the application print dialog box, more prints than intended may be printed.

Windows 95/98/Me

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties to set Locked Print.

CCCC Click to select the [Setup] tab.

DDDD Select [Locked Print] in [Job Type].

EEEE Click [Details...].

FFFF Enter the "User ID" in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. Then enter a password in [Password], up to four digits.

Note

❒ Select this to identify the user associated with the job.

GGGG Click [OK].
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Windows 2000/XP, Windows Server 2003, Windows NT 4.0

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Open the Printer Properties to set Locked Print.

CCCC Click to select the [Job Log] tab.

DDDD Select [Locked Print] in [Print Job].

EEEE Enter the "User ID" in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. Then enter a password in [Password], up to four digits.

Note

❒ Use this to identify the user associated with the job.

FFFF Click [OK] to close the Printer Properties.

GGGG Start printing from the application's print dialog box.

The Locked Print job is sent to the machine.
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Mac OS

AAAA From an application, select the menu command to print.

The print dialog box appears.

BBBB Click to select [Job Log] from the pop up menu.

CCCC Select [Locked Print] in [Job Type], and then select the appropriate setting.

DDDD Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)

characters. Then enter a password in [Password], up to four digits.

Note

❒ This is used to identify the user associated with a job.
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Collate

Use this function to enable collation. With this feature, the printer can efficiently print collated sets of

multiple-page documents.

Limitation

❒ To use this function, a Memory Unit of at least 128MB or Hard Disk Drive must be installed on the

printer.

❒ Under Windows 2000/XP, Windows Server 2003, Mac OS, or Mac OS X, make sure the following

check boxes have not been selected.

• Windows 2000/XP, Windows Server 2003

The [Collate] check box on [Paper/Output] on [Advanced...] on the [Paper/Quality] tab in the

Printing Preferences dialog box.

• Mac OS

The [Collate] check box in the print dialog box.

• Mac OS X

The [Collate] check box on [Copies & Pages] in the printer dialog box.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Collate] on the [Setup] tab.

Windows 2000/XP, Windows Server 2003 [Collate] on [Advanced...] on the [Paper/Quality] tab in the Printing 

Preferences dialog box.

Windows NT 4.0 [Collate] on [Document Options] on the [Advanced] tab in the Docu-

ment Defaults dialog box.

Mac OS [Collate] on [Printer Specific Options] in the print dialog box.

Mac OS X [Collate] on the [Feature 1] tab on [Printer Features] in the printer dia-

log box.
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Duplex Printing

Use this function to select duplex printing.

Limitation

❒ To use this function, the optional Duplex Unit must be installed on the printer.

❒ You cannot perform duplex printing from the Bypass Tray.

The following table shows the tabs or menus where you can select this function.

You can select the following items: The following items may vary depending on the operating system

you are using.

Windows 95/98/Me

❖❖❖❖ Off
Disables Duplex Printing.

❖❖❖❖ Open to Left
Prints output so that you can open it to the left.

Windows 95/98/Me [Duplex] on the [Setup] tab.

Windows 2000/XP, Windows Server 2003 [Print on Both Sides (Duplex)] on the [Layout] tab in the Printing Pref-

erences dialog box.

Windows NT 4.0 [Print on Both Sides (Duplex Printing)] on the [Page Setup] tab in the 

Document Defaults dialog box.

Mac OS [Print on Both Sides] on [Layout] in the print dialog box.

Mac OS X The [Print on Both Sides] check box on [Duplex] in the print dialog 

box.
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❖❖❖❖ Open to Top
Prints output so that you can open it to the top.

Windows 2000/XP, Windows Server 2003, Mac OS, Mac OS X

Note

❒ If you use a Mac OS, click to select the button that means “Flip on Long Edge” or “Flip on Short

Edge”.

❖❖❖❖ None
Disables Duplex Printing.

❖❖❖❖ Flip on Short Edge
Prints output so that you can open it to the short edge when bound along the short edge.

❖❖❖❖ Flip on Long Edge
Prints output so that you can open it to the long edge when bound along the long edge.

Windows NT 4.0

❖❖❖❖ None
Disables Duplex Printing.

❖❖❖❖ Short Side
Prints output so that you can open it to the short edge when bound along the short edge.

❖❖❖❖ Long Side
Prints output so that you can open it to the long edge when bound along the long edge.
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Color Mode

Use this to select whether the document is printed in color or black and white.

The following table shows the tabs or menus where you can select this function.

Note

❒ If you use Windows 95/98/Me, this mode is called "Color/Black and White".

You can select the following items:

❖❖❖❖ Color
Prints color documents in full color.

Note

❒ Color images will be printed using CMYK toner, Cyan, Magenta, Yellow and Black. CMYK are

three primary subtractive colors.

❒ If you want to adjust the print color, adjust the settings in the Advanced dialog box accessed from

the Advanced button on the [Paper/Quality] tab.

Windows 95/98/Me [Color Mode] on the [Setup] tab.

Windows 2000/XP, Windows Server 2003 [Color Mode] on [Advanced...] on the [Paper/Quality] tab in the Print-

ing Preferences dialog box.

Windows NT 4.0 [Color Mode] on [Document Options] on the [Advanced] tab in the 

Document Defaults dialog box.

Mac OS [Color Mode:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Mode] on the [Features 1] tab on [Printer Features] in the print 

dialog box.
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❖❖❖❖ Black and White
Prints everything, including color documents, in black and white. Black and White printing is faster

than Color printing. To stop black and white areas being printed with CMYK toner, select [Black

and White] in the printer driver as well as in the application.

Paper Selection

Paper Sources and Output Tray Tabs

Use this to select the media type, input tray, and output tray.

Limitation

❒ This function is for Windows 95/98/Me only.

Reference

For more information about the [Paper Sources and Output Tray] tabs. See the printer driver's Help.



21

Paper Size

Use this to select the size of paper you want to use.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about the paper sizes supported by this printer, see "Paper and Other Media

Supported by This Printer" in the Maintenance Guide.

Windows 95/98/Me [Size:] on the [Paper] tab.

Windows 2000/XP, Windows Server 2003 [Paper/Output] on [Advanced...] on the [Paper/Quality] tab in the Print-

ing Preference dialog box.

Windows NT 4.0 [Paper Size:] on the [Page Setup] tab in the Document Defaults dialog 

box.

Mac OS [Paper:] on the [Page Attributes] tab in the Page Setup dialog box.

Mac OS X [Paper Size:] in the Page Setup dialog box.
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Media Type

Use this to select the paper type.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about the media type supported by this printer, see "Types of Paper and Other

Media" in the Maintenance Guide.

Windows 95/98/Me [Type:] on [All Pages] on the [Paper] tab.

Windows 2000/XP, Windows Server 2003 [Media:] on the [Paper/Quality] tab in the Printing Preference dialog 

box.

Windows NT 4.0 [Paper/Output] on the [Advanced] tab in the Document Defaults dialog 

box.

Mac OS [Paper Type:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Paper Type] on the [Features 3] tab on [Printer Features] in the print 

dialog box.
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Paper source

Use this to select the paper sources.

The following table shows the tabs or menus where you can select this function.

Resolution

Use this to set the resolution to [600dpi] or [1200dpi].

Limitation

❒  When the resolution option is set to [1200dpi], the gradation option must be set to [Fast].

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [All Pages] on the [Paper] tab.

Windows 2000/XP, Windows Server 2003 The [Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 The [Page Setup] tab in the Document Defaults dialog box.

Mac OS [Paper Source:] on [General] in the print dialog box.

Mac OS X [Paper Feed] in the print dialog box.

Windows 95/98/Me [Advanced] on the [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Graphic] on [Advanced...] on the [Paper/Quality] tab in 

the Printing Preferences dialog box.

Windows NT 4.0 [Graphic] on [Document Options] on the [Advanced] tab 

in the Document Defaults dialog box.

Mac OS [Printer Specific Options] in the print dialog box.

Mac OS X [Resolution] on the [Features 1] tab on [Printer Features] 

in the print dialog box.
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Gradation

Use this to select a type of gradation based on your purpose.

The following table shows the tabs or menus where you can select this function.

You can select the following items:

❖❖❖❖ Standard
Prints with good quality of gradation.

❖❖❖❖ Fast
Prints quickly while gradation loses some smoothness.

Windows 95/98/Me [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Gradation] on [Advanced...] on the [Paper/Quality] tab in the Printing 

Preferences dialog box.

Windows NT 4.0 [Gradation] on [Document Options] on the [Advanced] tab in the Doc-

ument Defaults dialog box.

Mac OS [Gradation] on [Printer Specific Options] in the print dialog box.

Mac OS X [Gradation] on the [Features 1] tab on [Printer Features] in the print di-

alog box.
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Color Profile

Use this to select the color profile pattern.

The following table shows the tabs or menus where you can select this function.

You can select the following items:

Important

❒ If you use Windows 95/98/Me, you can configure [Color Profile] in [Advanced] by selecting [Manual]

from the[Color] setting. [Automatic] sets the printer to "Auto".

❖❖❖❖ Auto
Use this setting to configure the best color profile pattern automatically depending on the appear-

ance of the document to be printed.

❖❖❖❖ Photographic
Use this setting to enhance the reproduction of photos and graphics that include midtones.

Windows 95/98/Me The [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Color Profile] on [Advanced...] on the [Paper/Quality] tab in the Print-

ing Preferences dialog box.

Windows NT 4.0 [Color Profile] on [Document Options] on the [Advanced] tab in the 

Document Defaults dialog box.

Mac OS [Color Profile:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Profile] on the [Features 2] tab on [Printer Features] in the print 

dialog box.
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❖❖❖❖ Presentation
Use this setting to enhance the reproduction of documents that contain text and graphics. This CRD

is best for printing colored charts, graphs, presentation materials and so on. If you use this CRD for

printing photographs, the color or gradations might not be reproduced well.

❖❖❖❖ Solid Color
Use this setting to print specific colors, logos and so on.

❖❖❖❖ User Setting
Use this setting to print images with downloaded CRD from your application.

Note

❒ Use this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you

should select the appropriate CRD for the document you are printing. The selected CRD is also re-

ferred to when [Fine] or [Super Fine] is selected for "Color Setting". The following items are available:

[Auto],[Photographic], [Presentation] and [Solid Color].
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Color Setting

Use this to select the correction method used for color conversion.

The following table shows the tabs or menus where you can select this function.

Important

❒ If you use Windows 95/98/Me, you can configure [Color Setting] in [Advanced] by selecting [Manual]

from the [Color] setting. [Automatic] sets the printer to "Super Fine".

Note

❒ The color rendering dictionary that is selected in the "Color Profile" setting is used.

You can select the following items:

❖❖❖❖ Off
No modification to the color setting.

❖❖❖❖ Fine

Windows 95/98/Me [Advanced] on the [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Color Setting] on [Advanced...] on the [Paper/Quality] tab in the Print-

ing Preferences dialog box.

Windows NT 4.0 [Color Setting] on [Document Options] on the [Advanced] tab in the 

Document Defaults dialog box.

Mac OS [Color Setting:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Setting] on the [Features 2] tab on [Printer Features] in the print 

dialog box.
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Select this setting to perform color matching based on one of the printer's built- in color rendering

dictionaries and perform CMYK conversion. This setting performs the printing which output target

is Monitor γ = 1.8.

❖❖❖❖ Super Fine
Select this setting to use a color rendering dictionary as in the "Fine" setting but produce output that

is more vivid. Use this setting to emphasize light colors. This setting performs the printing which

output target is Monitor γ = 2.2.

Note

❒ Use this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you

should select the appropriate CRD for the document you are printing. The selected CRD is also re-

ferred to when [Fine] or [Super Fine] is selected for "Color Setting". The following items are available:

[Auto],[Photographic], [Presentation] and [Solid Color].
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Dithering

Use this to set the Image Rendering mode.

The following table shows the tabs or menus where you can select this function.

Important

❒ If you use Windows 95/98/Me, you can configure [Dithering] in [Advanced] by selecting [Manual] from

[Color] setting. [Automatic] sets the printer to "Auto".

You can select the following items:

❖❖❖❖ Auto
Use this setting to configure the best dithering method automatically depending on the appearance

of the document to be printed.

❖❖❖❖ Photographic
Performs dithering using an appropriate pattern for photographs.

❖❖❖❖ Text
Performs dithering using an appropriate pattern for text.

Windows 95/98/Me [Advanced] on the [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Dithering] on [Advanced...] on the [Paper/Quality] tab in the Printing 

Preferences dialog box.

Windows NT 4.0 [Dithering] on [Document Options] on the [Advanced] tab in the Doc-

ument Defaults dialog box.

Mac OS [Dithering] on [Printer Specific Options] in the print dialog box.

Mac OS X [Dithering] on the [Features 2] tab on [Printer Features] in the print di-

alog box.
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❖❖❖❖ User Setting
Use this setting to print images set in half tone in your application.

Gray Reproduction

Use this to select the Black Color mode for text and line art.

The following table shows the tabs or menus where you can select this function.

Important

❒ If you use Windows 95/98/Me, you can configure [Gray Reproduction] in [Advanced] by selecting [Man-

ual] from the [Color] setting. [Automatic] sets the printer to "Pure Black Text".

Note

❒ If you use Windows 2000/XP, Windows Server 2003, Windows NT 4.0, Mac OS or Mac OS X, this

function is called "Black Text/Graphics".

Windows 95/98/Me [Advanced] on the [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Black Text/ Graphics] on [Advanced...] on the [Paper/Quality] tab in 

the Printing Preferences dialog box.

Windows NT 4.0 [Black Text/ Graphics] on [Document Options] on the [Advanced] tab 

in the Document Defaults dialog box.

Mac OS [Black Text/Graphics] on [Printer Specific Options] in the print dialog 

box.

Mac OS X [Black Text/Graphics] on the [Features 2] tab on [Printer Features] in 

the print dialog box.
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You can select the following items:

❖❖❖❖ Pure Black Text
Select this setting to use a black toner.

Note

❒ If you use Windows 2000, Windows XP, Windows NT 4.0, Mac OS or Mac OS X, this mode is

called "K".

❖❖❖❖ CMY+K
Select this setting to use all toners.

Black Over Print

Select whether or not to apply a black color over any other colors when printing.

The following table shows the tabs or menus where you can select this function.

Important

❒ If you use Windows 95/98/Me, you can configure [Black Over Print] in [Advanced] by selecting [Manual]

from the [Color] setting.

Windows 95/98/Me [Advanced] on the [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Black Over Print] on [Advanced...] on the [Paper/Quality] tab in the 

Printing Preferences dialog box.

Windows NT 4.0 [Black Over Print] on [Document Options] on the [Advanced] tab in the 

Document Defaults dialog box.

Mac OS [Black Over Print:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Black Over Print] on the [Features 2] tab on [Printer Features] in the 

print dialog box.
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Toner Saving

Use this function to reduce the amount of toner used when printing.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Toner Saving] on the [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Toner Saver] on [Advanced...] on the [Paper/Quality] tab in the Print-

ing Preferences dialog box.

Windows NT 4.0 [Toner Saver] on [Document Options] on the [Advanced] tab in the 

Document Defaults dialog box.

Mac OS [Toner Saver:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Toner Saver] on the [Features 1] tab on [Printer Features] in the print 

dialog box.
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Color Control

Use this to select whether or not you want the colors in the documents to be adjusted before printing so

that the printed page matches closer to the colors on the screen.

The following table shows the tabs or menus where you can select this function.

Note

❒ If you use Windows 2000/XP or Windows Server 2003, this function is called "Image Color Manage-

ment".

❒ If you use Windows NT 4.0, this function can not be configured.

❒ If you use Mac OS, this function is called "Color Matching".

❖❖❖❖ Image Color Control
Display the Image Color Matching dialog box, click this button to specify exactly how you want the

colors on your screen adjusted before printing.

Windows 95/98/Me The [Print Quality] tab.

Windows 2000/XP, Windows Server 2003 [Graphic] on [Advanced] on the [Paper/Quality] tab in the Printing 

Preferences dialog box.

Windows NT 4.0 This function is not available.

Mac OS [Print Color] on the [Color Matching] tab in the print dialog box.

Mac OS X This function is not available.



34

User Code

Use this to set a user code for print logging.

Enter a user code using up to eight digits. A user code identifies a group of users and allows you to

check the number of sheets printed under each code with SmartDeviceMonitor for Admin.

The following table shows the tabs or menus where you can select this function.

Reference

For more information about using SmartDeviceMonitor for Admin, see Help.

Windows 95/98/Me [User Code] on the [Statistics] tab.

Windows 2000/XP, Windows Server 2003 [User Code] on the [Job Log] tab in the Printing Preferences dialog 

box.

Windows NT 4.0 [User Code] on the [Job Log] tab in the Document Defaults dialog box.

Mac OS [User Code] on [Job Log] in the print dialog box.

Mac OS X This function is not available.
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Options

See “Setting Up Options” in the Client Reference or the Administrator Reference for the installation

method appropriate to your printing environment.

The following table shows the tabs or menus where you can select this function.

❖❖❖❖ Tray 2

• You can select the tray with the following menu for PAPER FEED UNIT Type 3000:

Paper Source, see p.23 “Paper source”

❖❖❖❖ Tray 3

• You can select the other tray with the following menu for an additional PAPER FEED UNIT

Type 3000:

Paper Source, see p.23 “Paper source”

Note

❒ If you use Windows 2000/XP, Windows Server 2003, Windows NT 4.0, Mac OS or Mac OS

X, this menu is called "Tray 2 and 3".

Windows 95/98/Me [Option] on the [Accessories] tab.

Windows 2000/XP, Windows Server 2003 [Installable Options] on the [Device Setting] tab.

Windows NT 4.0 [Installable Options] on the [Device Setting] tab in the Document De-

faults dialog box.

Mac OS [Chooser] on the Apple Menu.

Mac OS X This function is not available.
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❖❖❖❖ Duplex Unit

• You can use the following function with AD440:

Duplex Printing, see p.17 “Duplex Printing”

❖❖❖❖ Hard Disk

• You can use the following function with Printer Hard Disk Type 3000:

Collate, see p.16 “Collate”

Note

❒ This function is for Windows 95/98/Me only.

❖❖❖❖ Total Memory

• You can use the following function with Memory Unit Type C (64/128/256 MB):

Collate, see p.16 “Collate”

Note

❒ The optional Memory Unit of at least 128MB must be installed on the printer.

❒ This function is for Windows 95/98/Me only.



372. Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of the printer and so on.

Limitation

❒ If a Macintosh and printer are connected by USB, you cannot use Printer Utility for Mac.

Note

❒ Printer Utility for Mac is included on the CD-ROM labeled “Printer Drivers and Utilities”.

❒ Printer Utility for Mac requires Mac OS 7.6.1-9.x, or Mac OS X 10.1.x or 10.2.1. Mac OS X 10.0.x

and 10.2 are not supported.

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.

AAAA Start the Macintosh.

BBBB Insert the CD-ROM into the CD-ROM drive.

The CD-ROM icon appears.

CCCC Double-click the hard disk icon to open it.

DDDD Double-click the CD-ROM icon.

The contents of the CD-ROM appear.

EEEE Double-click the [Mac OS 8 and 9] folder.

Note

❒ Under Mac OS X, double-click the [Mac OS X] folder.

FFFF Double-click the [PS Utility] folder on the CD-ROM.
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GGGG Double-click the [Printer Utility for Mac] folder.

HHHH Double-click the folder of the language you use.

IIII Move the “Printer Utility for Mac” file to the Macintosh hard disk using a drag-and-drop op-

eration.

JJJJ Drag the CD-ROM icon to the Trash to eject the CD-ROM.

Printer Utility for Mac is installed.
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Starting Printer Utility for Mac

Mac OS

Important

❒ Before starting Printer Utility for Mac, make sure the printer is selected in [Chooser] on the Apple

menu.

AAAA Double-click the Printer Utility for Mac icon.

The [Printer Utility for Mac] dialog box appears.

BBBB Click [OK].

Printer Utility for Mac will take a few seconds to start.

Reference

For more information, see p.41 “Printer Utility for Mac Functions”.



40

Mac OS X

AAAA Double-click the Printer Utility for Mac icon.

The [Printer Utility for Mac] dialog box appears.

BBBB Click [OK].

CCCC In the [Available Printers:] box, select the printer you want to use.

Note

❒ If you change zones, select a name from [Available Network Zones:].

❒ Click [Choose Printer...] on the Printer Utility for Mac menu if you want to change the printer.

DDDD Select the printer you want to use.

Printer Utility for Mac will take a few seconds to start.

EEEE Click [Choose].

Reference

For more information, see p.41 “Printer Utility for Mac Functions”.
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Printer Utility for Mac Functions

Printer Utility for Mac functions are described below.

❖❖❖❖ File menu

• [Download PS Fonts...]
Download fonts (PostScript Type 1) to the printer. See p.42 “Downloading PS Fonts”.

• [Display Printer's Fonts...]
Display and delete the fonts in printer memory and the printer's hard disk drive. See p.43 “Dis-

playing Printer's Fonts”.

• [Initialize Printer's Disk...]
Initialize the printer's hard disk drive. See p.45 “Initializing the Printer Disk”.

• [Page Setup...]
Set up the paper size to print “Printer Font Catalog” and “Printer Font Sample”. See p.46 “Page

Setup”.

• [Print Font Catalog...]
Print the names of available fonts. See p.46 “Printing Font Catalog”.

• [Print Font Sample...]
Print a sample of fonts. See p.46 “Printing Font Sample”.

• [Rename Printer...]
Change the printer's name when viewed via Appletalk. See p.47 “Renaming the Printer”.

• [Restart Printer]
Restart the printer. See p.48 “Restarting the Printer”.
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❖❖❖❖ Utility menu

• [Download PostScript File...]
Download a PostScript File. See p.49 “Downloading PostScript Files”.

• [Select Zone...]
Change the zone to which the printer belongs to via Appletalk. See p.49 “Selecting the Zone”.

• [Display Printer Status...]
Display the status of the printer. See p.50 “Displaying the Printer Status”.

• [Launch Dialogue Console...]
Create and edit a PostScript file, and then download it to the printer. See p.51 “Launching the

Dialogue Console”.

Downloading PS Fonts

You can download the PS fonts to the printer's memory or hard disk drive.

Important

❒ The following procedures to download the fonts assume that you are a system administrator. If you

are not, be sure to consult your system administrator.

❒ If the printer restarts, all the printer settings return to their defaults.

❒ Confirm that a Macintosh and the printer are connected with Appletalk.

Note

❒ Some fonts cannot be downloaded.

❒ Before downloading, read the documentation about the fonts you want to use.

AAAA Select [Download PS Fonts...] on the [File] menu.

BBBB Click [Add to list].

The dialog box to select fonts appears.
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CCCC Click to select the desired font files, and then click [Open].

The list of selectable font names appears.

DDDD After adding all the fonts you want to download, click [OK].

The dialog box of selected fonts to download appears.

EEEE Click [Download].

The fonts begin to download, and the download status is shown.

Important

❒ During the download, do not turn off the power switch, operate the panel or open or close the

cover.

FFFF When the completion message appears, click [OK].

GGGG Click [Cancel].

Displaying Printer's Fonts

You can display the available fonts currently downloaded to the printer. Fonts in the printer's memory

and hard disk drive can be displayed.

Note

❒ The fonts displayed in italics are the default fonts.

AAAA Select [Display Printer's Fonts...] on the [File] menu.

A dialog box appears.

BBBB Select [Printer's memory] or [Printer's disk].

CCCC Click [OK].
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Deleting Fonts

You can delete fonts from the printer's memory or hard disk drive.

AAAA Select [Display Printer's fonts] on the [File] menu.

A dialog box appears.

BBBB Select [Printer's memory] or [Printer's disk].

CCCC Select the fonts you want to delete.

Limitation

❒ You cannot delete the fonts displayed in italic.

DDDD Click [Delete].

A confirmation message appears.

EEEE Confirm the fonts you want to delete and the printer name from which you want to delete the

fonts.

FFFF Click [Continue], and then click [OK].

GGGG Click [OK].
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Initializing the Printer Disk

When initializing the printer's hard disk, all the fonts downloaded to the printer's hard disk drive are

deleted. Before initializing, be sure to check the fonts on the hard disk drive.

Important

❒ When initializing the printer's hard disk drive from the operation panel, all of the data on the printer's

hard disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive.

AAAA Select [Initialize Printer's Disk...] on the [File] menu.

The confirmation message appears.

Note

❒ To cancel initialization, click [Cancel].

BBBB Click [Execute].

Initializing starts.

Important

❒ Do not turn off the power switch until initializing is completed, otherwise the hard disk drive might

be damaged.

CCCC When the completion message appears, click [OK].
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Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints Fonts Sample”.

AAAA Select [Page Setup...] on the [File] menu.

BBBB Choose the paper size.

Printing Font Catalog

Print the names of fonts available on the printer.

Note

❒ The paper selected under [Page Setup] is used.

AAAA Select [Print Fonts Catalogue] on the [File] menu.

BBBB Click [Print].

Printing Font Sample

You can print samples of fonts downloaded to the hard disk drive or memory.

Note

❒ Print by using the paper selected on [Page Setup].

AAAA Select [Print Fonts Sample...] on the [File] menu.

BBBB Click [Print].
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Renaming the Printer

You can change the printer's name displayed under Appletalk. If you connect several printers on the

network, assign different names so you can identify them. If several printers have the same name, a digit

appears next to the printer name in [Chooser].

AAAA On the [File] menu, click [Rename Printer...].

BBBB In the [New Name:] filed enter a new name.

Limitation

❒ You can enter up to 31 digits and letters.

❒ Do not use symbols, for example “*”, “:”, “=”, “@”, “~”.

CCCC Click [Rename].

The printer name is changed.

DDDD Click [OK].

Mac OS

A On the Apple menu, click [Chooser].

B Click the [AdobePS] icon.

C Select the printer whose name you changed in step B, and then close the [Chooser] dialog

box.

Note

❒ If there are several Appletalk zones, select the zone the machine belongs to.
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Mac OS X

A On the [Printer Utility for Mac] menu, click [Choose Printer...].

B In the [Available Network Zones:] list, select the zone for the Macintosh in use.

C In the [Available Printers:] list, select the printer whose name you changed in step B, and

then click [Choose].

Restarting the Printer

You can restart the printer.

AAAA Select [Restart Printer] on the [File] menu.

BBBB Confirm the message that appears on the screen, and then click [Restart].

The printer restarts.

Note

❒ The fonts that you downloaded in the printer's memory will be deleted.

❒ If the printer restarts, all the printer settings return to their defaults.
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Downloading PostScript Files

You can download a Postscript file to the printer.

AAAA Select [Download PostScript File...] on the [Utility] menu.

BBBB Select the file name to download and click the file name, and then click [Open].

CCCC Type the log file name, and then click [Save].

The selected file is downloaded.

Note

❒ Errors are recorded in the log file.

Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.

Important

❒ Confirm that a Macintosh and printer are connected with Appletalk.

AAAA On the [Utility] menu, click [Select Zone...].

The zone to which the printer belongs and the available zone list appear.

BBBB Select the zone which you want to locate the printer in, and then click [Change].

A confirmation message appears.

CCCC Click [Continue].

A confirmation message appears.

DDDD Click [OK].
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Mac OS

A On the Apple menu, click [Chooser].

B Click the [AdobePS] icon.

C In the [Appletalk zone:] list, select the zone changed in step B.

D In the [Select a PostScript Printer:] list, select the printer you want to use.

E Close the [Chooser] dialog box.

Mac OS X

A On the [Printer Utility for Mac] menu, click [Choose Printer...].

B In the [Available Network Zones:] list, select the zone changed in step B.

C In the [Available Printers:] list, select the model of printer in use, and then click [Choose].

Displaying the Printer Status

You can display and confirm the current status of the printer.

AAAA Select [Display Printer Status...] on the [Utility] menu.

The current status of the printer appears.

BBBB Confirm the current status of the printer.

You can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive status

and available space on the hard disk drive. You can also confirm the zone to which the printer be-

longs to.

CCCC Click [OK].
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Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the printer.

Important

❒ “Launch Dialogue Console” is recommended for users with an understanding of PostScript.

❒ Do not download any file other than PostScript files to the printer.

❒ “Launch Dialogue Console” must be used at your own responsibility.

AAAA Select [Launch Dialogue Console...] on the [Utility] menu.

Open the editing screen. The Dialogue Console menu bar appears.

BBBB Type the PostScript command in the editor screen.

Note

❒ To edit a PostScript file, select [Open] on the [File] menu to open it.

❒ You can search or replace a character string by using the [Search] menu.

CCCC After editing the PostScript file, select [Download Top Window] on [Console] menu to start print-

ing.

The PostScript file is sent to the printer.

Note

❒ The [Reply from Printer] box opens, depending on the PostScript file you sent.

DDDD Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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